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HP OpenView Service Desk 
for the Windows and UNIX operating systems 

Release Notes 
Software version: 5.0 Patch 2 / 14 August 2006 

This document provides an overview of the changes made in HP OpenView Service Desk 5.0 Patch 2. This 
document contains important information not included in the manuals or the online help. 
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•  Known Problems, Limitations, and Workarounds 

•  Accessibility Support 

•  Integration with Other HP OpenView Solutions 

•  Troubleshooting 

•  Support 

•  Legal Notices 
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In this Version 

For information about the differences between HP OpenView Service Desk 4.5 and HP OpenView Service 
Desk 5.0, refer to HP OpenView Service Desk 5.0 Differences Between 4.5 and 5.0. 

The Extraction Configuration Wizard (ECW) was included by mistake in Service Desk 5.0. ECW is not 
supported in Service Desk 5.0. It is not included in Service Desk 5.0 Service Pack 1. 

Documentation Updates 

The first page of this document contains the following identifying information: 

•  Version number, which indicates the software version. 

•  Publish date, which changes each time the document is updated. 

To check for recent updates, or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name.  

2 In the Version list, click the version number.  

3 In the OS list, click the OS type.  

4 In the document list, click the document title.  

5 To retrieve the document, click Open or Download.  

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL:  

http://www.adobe.com 

In Service Desk 5.0 Service Pack 1, the HP OpenView Service Desk Concepts Guide is available. 

When the OVO integration is released, the HP OpenView Service Desk OpenView Operations Integration 
Administrator’s Guide will be available. When the other integration software is released, an updated HP 
OpenView Service Desk Data Exchange Administrator’s Guide will also be available.  
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Documentation Errata 

This section describes the following: 

•   Any errors in the published documentation 

•   Latest information that could not be included in the published manuals or online help 

HP OpenView Performance Insight 

Components 

To use HP OpenView Performance Insight (OVPI) with Service Desk 5.0, you need to purchase the following 
components: 

•  HP OpenView Performance Insight 5.1 

•  HP OpenView Performance Insight Database Connector (one for each Service Desk server from which 
you want to report) 

•  Your choice of the following: 

  HP OpenView Performance Insight Report Pack for Helpdesk Manager 

  HP OpenView Performance Insight Report Pack for Change Management 

  HP OpenView Performance Insight Report Pack for Service Level Management 

Media and manuals for HP OpenView Performance Insight are purchased separately. The manuals are 
available in PDF format on the CDs. 

Starter Bundle 

The HP OpenView Performance Insight Starter Bundle for Service Desk 5.1 includes the following:  

•  HP OpenView Performance Insight 5.1  

•  HP OpenView Performance Insight Database Connector 

•  HP OpenView Performance Insight Report Pack for Helpdesk Manager 

Prerequisites 

OVPI 5.1 supports only Oracle Database 9.2.0.5 with the partitioning feature configured. It does not support 
Windows XP. 
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Installation Notes 

The following install scenarios are supported: 

•  Fresh 

When installing the software for the first time. 

•  Upgrade 

When upgrading a previous version of the software, database, or both. 

•  Secondary server 

When upgrading a secondary server installation. 

On Windows, when you upgrade any Service Desk component, make sure it is not in use. Before you 
upgrade, stop all Service Desk processes on your system using the ovc command. If you do not stop the 
processes, it is possible that files currently in use will not be updated, and will be removed after a reboot. For 
information about using the ovc command (for example, to view status and to start and stop processes), refer 
to the HP OpenView Service Desk Installation Guide. 

If you upgrade the Service Desk agent in a Windows environment, no message displays telling you to reboot 
the machine. You must, however, reboot the machine after the agent has been upgraded. 

 

Software and Hardware Requirements 

Before installing HP OpenView Service Desk 5.0, make sure your system meets the following minimum 
requirements:  

•  OS platform and compatibility  

  Supported operating systems  

For information about the supported operating systems, and corresponding system requirements, 
refer to the HP OpenView Service Desk 5.0 Installation Guide.   

  Operating system patches required for Sun Java  

The operating system of the machine on which Service Desk will be installed must be upgraded with 
the most recent operating system patches related to the Java Runtime Environment (JRE). Failure 
to install these patches may result in one or more subsequent components failing to install. This 
problem is especially critical on HP-UX 11. 

Patches should be installed before you install the Java software. Some patches are absolutely 
necessary to run Java. Others are recommended for optimum performance. HP recommends that you 
install all patches needed for your system configuration. 

•  Software  

  Database server  

For information about supported databases, refer to the HP OpenView Service Desk 5.0 Installation 
Guide. 

The use of the Unicode character set AL32UTF8 is recommended on Oracle. If you want to use the 
Unicode character set as your default character set, you must create the Oracle instance for 
supporting Unicode. 
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For an Oracle Database, you should possess the appropriate rights (DBA account and password) for 
creating new Oracle Database users. 

  Microsoft SQL Server configuration  

Configure Microsoft SQL Server to accept non-Windows user name and password logons. You can 
configure this acceptance in the properties window of the SQL Server instance. Set the 
Authentication to “SQL Server and Windows.” 

NOTE: If you have installed a previous version of HP OpenView Service Desk, remove the 
OVXPL_DATA_DIR, OvDataDir and OvInstallDir environment variables before reinstalling. 

Installation Problems 

This section provides workarounds to known installation problems. 

Installation Problems on Solaris 9 and 10 
Problem 

On Solaris, a Finalize action warning message is displayed at the end of the installation. The 
application installer tries to start all the processes and the ovobs process fails.  

The error message states the following: 

Finalize action for HP OpenView Service Desk Management  

Server (Starting the server.) was not successful. 

After the installation, the following status displays: 

Ovcd        OV Control                CORE         (2434)   Running 

ovbbccb     OV Communication Broker   CORE         (2435)   Running 

ovloginsv   OV Login Server           JAVA                  Stopped 

ovapacheA   OV Apache(A) WebServer Service   WEB            Aborted 

ovsdma      OV SLM OVSD Metric Adapter SLM         (2757)   Running 

ovtomcatA   OV Tomcat(A) Servlet Container   WEB   (2625)   Running 

ovsdslm     OV Service Level Management SLM        (2762)   Running 

ovobs       OV Object Server            OBS                 Aborted 

ovcs        OV Certificate Server       SERVER     (2763)   Running 

ovsdreport  OV Service Desk Reporting   SDREPORT            Aborted 

This problem is linked to the value of the timeout of the OV Control process, which is too small for Solaris 
systems.  

Workaround 

Enter the following commands: 

1 ovc –kill 

2 ovconfchg -ns ctrl.ovcd -set ACTION_TIMEOUT 120 

3 ovc -start 
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QXCR1000315787:  
Apache Startup 
Problem 

For all UNIX systems in an NIS-controlled environment, the OvApacheA package, installed during the 
Service Desk Management Server installation, does not create the user ovwebusr or the group ovwebgrp. 

Workaround 

To solve this problem, create the user ovwebusr and the group ovwebgrp manually on the Network 
Information Service (NIS) server. Create the user and group after installing the OvApacheA product but 
before starting the OvApacheA WebServer service. 

To create the user ovwebusr and the group ovwebgrp, follow these steps. 

1 Add the group ovwebgrp:  

groupadd ovwebgrp 

2 Add the ovwebgrp group: 

useradd -G ovwebgrp ovwebusr 

3 Restart the Apache process: 

ovc -start ovapacheA 

Installation Freezes 
Problem 

If the installation screen remains static for a very long time, your machine may have frozen. 

Workaround 

To prevent the installation from freezing, follow these steps: 

1 Download scripten.exe from the Microsoft web site: 

http://www.microsoft.com 

2 Run the scripten.exe file. 

3 Restart your computer. 

4 Run the setup.exe file again. 

Error Messages in the Log Files 
Problem 

You encounter error messages in the following log file: 

C:\Program Files\HP OpenView\data\log\system0.0.en_US 

Example: 

Oct 18, 2005 9:01:48 AM;5;10;com.hp.ov.obs;SEVERE;SQL Exception: JDBC error 942: 
ORA-00942: table or view does not exist, SQL state: 42000 for query: select 1 from 
itsm_personsjava.sql.SQLException: ORA-00942: table or view does not exist 

Workaround 

None. Do not be alarmed. These messages do not impact the behaviour of the application. 
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QXCR1000312290: 
Unable to Depersist an Object 
Problem 

The following message appears in the system0.0.en_US log file: 

Jan 19, 2006 4:20:52 PM;99;19;com.hp.ov.obs;SEVERE;Unexpected error  

deserializing a JavaObject. Exception: {0} 

java.io.StreamCorruptedException: Unable to depersist an object  

(com.hp.ov.ui.ext.core.view.chart.ChartViewInfo). 

null    at com.hp.ov.obs.util.Streamer.readObject(Streamer.java:365) 

        at com.hp.ov.obs.util.Streamer.readObject(Streamer.java:100) 

        at com.hp.ov.obs.util.ObsUtils.deserialize(ObsUtils.java:901) 

        at com.hp.ov.obs.util.RsObjectValue.getObjectValue 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Uninstall Steps (Windows Only) 

This section describes how to uninstall HP OpenView Service Desk 5.0, and remove its files, on Windows 
systems. 

Uninstall Service Desk 
To remove a Service Desk component from your Windows system, follow these steps: 

1 In the Windows Control Panel, select Add/Remove Programs to uninstall the software. 

2 Remove the Service Desk files and the Self-Healing Services registry key. 

Remove Service Desk Files 
CAUTION: Perform the following cleanup operation only if Service Desk 5.0 has been previously installed 
on your system, and only if you do not have other HP OpenView products (for example, HP OpenView 
Internet Services) installed. 

To remove Service Desk 5.0 files, follow these steps: 

1 Delete the location where you installed the software. 

The default install location is as follows: 

C:\Program Files\HP OpenView 

2 Delete the HP OpenView registry key: 

HKEY_LOCAL_MACHINE\Software\Hewlett-Packard\HP OpenView 

3 Remove the following services: 

  HP OpenView Shared Trace Service 

  HP OpenView Apache(A) WebServer Service 

  HP OpenView Ctrl Service 

  HP OpenView Tomcat(A) Servlet Container Service 

  HP OpenView Communication Broker 
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4 Delete the following folder: 

C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView 

5 Delete the following environment variables: 

  OvDataDir 

  OvInstallDir 

  OvXpl_data_dir 

  WAPP_HOME 

6 In the %PATH% environment variable, remove the following reference: 

C:\Program Files\HP OpenView\bin 

7 In the %TEMP% folder, delete the ovinstallparams.ini file. 

8 Reboot the system. 

Remove the Self-Healing Services Registry Key 
Remove the following registry key manually: 

HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\SH Services\Supportability Adapter\dc 

The value is SDESK. 

Fixes 

This section describes defects fixed by Service Desk 5.0. 

Fixes in Patch 2 

Defect Description 

QXCR1000278810 Browser Node does not refresh if the view is changed. 

QXCR1000284568 Authentication should be case-insensitive. 

QXCR1000295296 Data Exchange XML Viewer must use a new implementation. 

QXCR1000295764 New Menu Iitem in Advanced Find is confusing and is not task-oriented. 

QXCR1000301790 Management of errors when the reporting config tool is running. 

QXCR1000313114 ALT GR key changes the focus from the text field to the menu. 

QXCR1000313147 Configuration Item map shows all related CIs. 

QXCR1000315989 Datafeeder: Need to be more precise when catching SQL exceptions. 

QXCR1000319825 Cannot add more than 49 minutes in a scheduled condition. 

QXCR1000320438 Attributes disappear from the list when a two-part attribute is made a required field. 

QXCR1000320711 Ovconsolecmd is missing the -ListAlways command. 

QXCR1000324506 Boolean field of the type button is not displaying correctly. 

QXCR1000324594 SD 5.0: Disabling UI rule prevents the prompt: Do you want to save the 
changes… 

QXCR1000324920 Carriage returns in the "zoom in" window for the UI rule are not recognized by SD 5.0. 
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QXCR1000325473 Impossible to modify the length of an icon label in a service hierarchy. 

QXCR1000325481 Specialist cannot use inbound email to log a Service Call. 

QXCR1000325692 Expression parser cannot communicate with the command-line tool for GUIFW. 

QXCR1000327058 Field Approval Group is not working in the db-database rule. 

QXCR1000328257 View-only field is not copied to a new item. 

QXCR1000329192 NullPointerException is thrown when trying to open relationships in a map view. 

QXCR1000329267 Evaluation period has only 29 days when changing from February to March. 

QXCR1000330128 Items rights are not given when a folder is not defined in a form. 

QXCR1000333251 Exception is thrown when defining selection criteria in View Filter/Advanced Find. 

QXCR1000333606 Code fields are not sent in Data Exchange with the External System Database Rule. 

QXCR1000333897 Setting an assignment to a workgroup using a data update from an external system 
action does not work properly. 

QXCR1000333905 Data from a custom person field is not sent as a parameter in a Data Exchange action. 

QXCR1000333949 Not able to use a child entity attribute as a search criterion. 

QXCR1000334576 There is a possible upgrade failure when the template hierarchy is changed. 

QXCR1000334980 Service Pack 1 installation does not upgrade the AutoPass component. 

QXCR1000337643 None in Grouping and Sorting dialog boxes cannot be localized. 

QXCR1000337647 Tools→Options web options page is not localized. 

QXCR1000338156 Sub-view title is not localized (L10N). 

QXCR1000338201 ID after creation popup message text is not fully localized (L10N). 

QXCR1000338574 Characters in the SD Console are not translated into Korean (L10N). 

QXCR1000338726 ohwconfig.xml is missing the port number for the English instance of OHW. 

QXCR1000339288 L10N: ARCH attribute is missing in OVII packages for the GUI. 

QXCR1000340056 There is a SD 5.0 database user password security issue on UNIX application servers. 

QXCR1000340104 Some labels cannot be localized. 

QXCR1000340132 Label in the explorer view setting cannot be localized. 

QXCR1000340679 Label in the Search Panel cannot be localized. 

QXCR1000341061 L10N: Single quotation mark has disappeared. 

QXCR1000341768 Label in Open (Choose Form) cannot be localized. 

QXCR1000341843 Sent date is incorrect in outbound email. 

QXCR1000342232 $ACCOUNTNAME$ system variable refers to the wrong attribute. 

QXCR1000343866 Demo data is inserted with an upgrade. 

QXCR1000343890 GUI should use Application.getMessage() to retrieve fully localized texts. 

QXCR1000344158 During an upgrade, customer settings are reset. 

QXCR1000344759 Limited amount of database views are created in Microsoft SQL Server. 

QXCR1000344828 Search definition does not open because of IndexOutOfBoundsException. 

QXCR1000352534 OutofMemoryException during upgrades. 

QXCR1000347528 Sometimes, license consumption calculation does not work correctly. 
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Fixes in Service Pack 1 

Defect Description 

QXCR1000284568 Authentication should be case-insensitive. 

QXCR1000297062 To Deadline not available in the Format rules of Views. 

QXCR1000301842 Calendar controls do not work. 

QXCR1000302073 The Match Case option is not available in Advanced Find yet. 

QXCR1000305153 Cancel form does not cancel changes. 

QXCR1000306115 UI Rule blocks the DB Rule. 

QXCR1000306288 Question about ovconsolecmd. 

QXCR1000306291 Missing Relations when using the system action Create Work Order. 

QXCR1000306771 In DB and UI rules, the classification criterion does not show values. 

QXCR1000306785 Chart view by month causes classcastexception. 

QXCR1000306815 Cannot save records. The attribute OID must be unique. 

QXCR1000309086 Entities that have view-only access generate query builder errors on history. 

QXCR1000309175 After you click the close icon in the Quick Find window, you cannot open the window. 

QXCR1000309636 Problem when using offsets for dates in templates. 

QXCR1000310151 “Your installer for this operating system is not enabled.” 

QXCR1000313147 Configuration item map shows all related CIs. 

QXCR1000315387 Problem with import mappings on the custom fields. 

QXCR1000317617 Database Export/Import possible using OvObsConfig. Is this supported? 

QXCR1000317950 Cannot use %line.separator% in Database rules. 

QXCR1000321016 OVConsoleCmd in Smart Action cannot use quotes in Smart Action parameters. 

QXCR1000302856 Modified role only propagated when the server cache is cleared. 

QXCR1000304295 Query manager gives error: Query Builder cannot join tables. 
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Known Problems, Limitations, and Workarounds 

This section describes known problems, limitations, and related workarounds for Service Desk. 

General Problems 

This section describes how to work around general problems you may encounter with Service Desk. 

 
Upgrade on Clients Overwrites ovconsole.bat 
Problem 

When applying Service Desk 5.0 SP1 on Service Desk 5.0 clients, the ovconsole.bat file is overwritten by 
the installer. As a result, all of the modifications made to this file are lost. 

Workaround 

Make a copy of the ovconsole.bat file before upgrading a client. After the upgrade has finished, apply the 
changes you made in the old file to the new file. 

 
Restart of HP OpenView Ctrl Service Produces Error 193 
Problem 

When starting the HP OpenView Ctrl service from the windows services screen, error 193 is returned. 

This error is caused by the path leading to the executable “<installdir>\bin\ovcd.exe” not being 
registered between quotes on the system. 

This problem is found on systems that have a file called “program” in the root of the installation directory 
(for example, c:\program). 

Workaround 

Either remove the file called “program” from the installation directory or use the registry editor to 
encapsulate the path to the executable in quotes.  

In HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\OvCtrl add quotes around the data in 
“ImagePath”. 

Incorrect Messages in the Log Files During Installation 
Problem A 

In the system0.0.en_US log file, the following message appears twice consecutively: 

"com.hp.ov.obs.security;SEVERE;441No Passwords in License File error code: 5997" 

Workaround A 

You can safely ignore this message. It does not indicate a severe problem with the software. 
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Problem B 

During the installation of Service Desk 5.0 on Solaris, in the system0.0.en_US log file, the following 
message appears: 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdma.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvsdMA.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvSdSlm.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdslm.xml'. 

Workaround B 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Log-on Exceptions 
Problem 

After you install Service Desk, you encounter a log-on exception.  

Workaround 

Before using the Secure Socket Layer logon, execute the OvObsClientSettingsEditor.bat file. 

Failure to execute this file results in the following error message: 

Javax.security.auth.LoginException: Failed to login due to RpcException: unexpected 
HTTP status: 503 Service Unavailable. 

For information about the user authentication mechanisms available, including the use of the Lightweight 
Directory Access Protocol (LDAP) and Active Directory, refer to the Service Desk online help:  

1 In the Contents tab of the Help Navigator window, go to Information for Administrators→Users & 
Security. 

2 Read the “User  Authentication,” “Principal Mappings,” and “Accounts” topics.   

NOTE: For the latest information about Active Directory user authentication, see “Active Directory User 
Authentication” in this document.   

 
QXCR1000349082:  
Content of the Latest Software Version Dialog in General Settings Has Disappeared 
Problem 

The URL content of the latest software version in general settings is emptied during the upgrade to Patch 2. 

Workaround 

None. 

QXCR1000327004:  
Installing Secondary Server Displays Install Database Content Warning 
Problem 

When choosing the “secondary install” option at the end of the installation process, the following warning 
displays: Install database content action failed. 

Workaround 

You can safely ignore this message. It does not indicate a severe problem with the software. 
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QXCR1000329577: 
Self-Healing Registry Key Remains After Patch is Uninstalled 
Problem 

A registry key remains after Service Desk is uninstalled. 

Workaround 

Remove the following registry key manually: 

HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\SH Services\Supportability Adapter\dc 

The value is SDESK. 

QXCR1000244984:  
Incidents Generated by the Alarm Engine are Not Filled Correctly 
Problem 

For all incidents created by the alarm engine, the associated service level is not correct. It is always the 
same for all of the incidents. 

Workaround 

You can modify the configuration item (CI) linked to the incident. Because the incident is created 
automatically for the specific CI, the user should not be able to modify the CI. 

Expected behavior: 

•  Service level must be set with the right service level name. 

•  User cannot modify the value of the incident CI field. 

QXCR1000283641:  
Searching for Text from “Localized Text” Does Not Work 
Problem 

By default, it is not possible to search for text in Localized Text or its subfolders.  

NOTE: If you select one of the subfolders of Localized Text, and run Advanced Find, this subfolder becomes 
available to the search engine, and is added as a searchable folder at the bottom of the list in Advanced Find. 
These changes are lost again after you restart the console. 

To reproduce the problem, follow these steps: 

1 Click OV Configuration→Presentation→Localized Text, and select the Localized Text folder. 

2 Open the Advanced Find form by pressing F2 or clicking Advanced Find in the menu bar. 

3 Search for localized text in Localized Text and in one of its subfolders. 

Expected results: 

The Advanced Find form opens. The Show field contains Localized Text. You can select one of its subfolders 
(for example, Label Text). You can run a search in Localized Text and in one of its subfolders. 

Actual results: 

Pressing F2 does not open the Advanced Find form. Clicking the Advanced Find button in the menu bar 
opens Advanced Find, but Localized Text and its subfolders are not available to the search. You cannot 
select them in the Show field. 

Workaround 

None. 
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QXCR1000242246:  
{I18N} Apache Service is Not Registered in the OS When Installed in a Non-ASCII Path 
Problem 

When a Service Desk installation includes an Apache server (such as the Service Desk 5.0 Server 
installation), and is installed in a path that contains non-ASCII characters (for example Chinese, Japanese, 
or Russian), the Apache server is not installed properly.  

As a result, all functionality that relies on the Apache server does not work: 

•  Java Web Start client 

•  Web UI 

•  Service pages 

•  Attachments 

•  Online help 

Workaround 

None. 

Service Level Management 

This section describes known problems, limitations, and workarounds related to Service Level Management 
(SLM) in Service Desk. 

Metric Adapters: Tuning the Query Limitations 
Problem 

The query restriction in the HP OpenView console can be set to display a maximum of 500 metric definitions 
and 1,000 metrics. The query restriction is required to use OVPA metrics or any other metrics with big 
volumes. 

Workaround 

To disable the query restriction, follow these steps:  

1 In the OV Configuration workspace, select Presentation. 

2 In the panel, select Search.  

3 Double-click and select No Restriction (instead of Restricted To) for each of the following objects:  

  Metric Definition  

  OVxx Metric  

  OVxx Metric Definition  
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QXCR1000244984:  
Incidents Generated by the Alarm Engine are Not Filled Correctly 
Problem 

When an incident is generated by the SLM Alarm Engine, its service level attribute is not related to the 
generation of the incident. 

Instead, the service level determination works as follows: 

•  If the related configuration item has a service level, that service level is taken. 

•  If not, the default service level is used. 

Workaround 

None. 

QXCR1000329267:  
Evaluation Period Has Only 29 Days When Changing from February to March 
Problem 

The problem was observed by the change of the evaluation period from February to March. The SLA has a 
monthly Evaluation Period that starts on January 1 00:00:00. In March, the report shows that the 
Evaluation Period is from March 1 to March 29, 2006. It should be from March 1 to March 31, 2006. For 
March, the Evaluation Period had been changed from one month to 29 days. The next report shows that the 
Evaluation Period is from March 29 to April 29, 2006. The Evaluation Period has shifted. 

Although the scenario described is fixed, a similar problem had been discovered dealing with time zone 
conversions. For example, if the actual SLA start date is March 1 00:00:00 CET, this value is converted into 
the GMT time zone, which is February 28 23:00:00 GMT. For a monthly evaluation period, the End date is 
March 28 23:00:00 GMT (March 29 00:00:00 CET). The result is a monthly period from March 1 00:00:00 
CET to March 29 00:00:00 CET. 

Workaround 

A workaround can be applied for this scenario. Changing the SLA Actual Start to March 1 01:00:00 CET 
results in an Evaluation Period from March 1 01:00:00 CET to April 1 02:00:00 CET. 

Until a full solution is delivered, it is recommended that you not set the SLA Actual Start to March 1, May 1, 
July 1, October 1, or December 1. Although you can still use these dates, you need to make sure that the 
time converted to GMT is still on the first day of the month. 
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QXCR1000316864:  
Severe Errors in Join Tables Operation 
Problem 

Severe errors are logged in the Object Server log file. All the errors are related to a Join Table Operation. 
The severe errors associated with the query builder error on join tables are generated when you try to 
remove a service definition that has an associated service.  

In the log files, the following traces are created: 
Feb 10, 2006 3:24:39 PM;99;11;com.hp.ov.obs;SEVERE;Error 

com.hp.ov.obs.impl.util.DeveloperException: Query Builder can not join tables cdm_services 
[281478426132597] and cdm_services_x [272934308553576458]. 

Check relations between cdm_services on one hand, and cdm_services_x and cdm_services_x on the other. in 
method createReferencedTable 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.createReferencedTable(AppQueryBuilder.java:1392) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.makeJoin(AppQueryBuilder.java:2025) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2595) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.listWhereParts(AppQueryBuilder.java:2610) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.createConcreteQuery(AppQueryBuilder.java:335) 

 at com.hp.ov.obs.impl.da.AppQueryBuilder.createQueryBuilder(AppQueryBuilder.java:223) 

Workaround 

You can safely ignore these traces. They do not indicate a severe problem with the software. 

QXCR1000299666:  
SLM Licensing: No Messages Sent to the Client Console 
Problem 

When an SLM licensing problem occurs, no message is sent to the client console, but all licence events are 
logged in the SLM log file. For example, if the number of services authorized by licenses is reached, you can 
create a new service, but the SLA Activity Status remains not managed. 

SLM manages only the number of services licensed. If a greater number of services are ready in the CMDB 
for SLM management, only a licensed number of services are managed. The other services are not managed. 
The non-managed services are listed only in the log file, and the SLM management status may be 
inaccurate. 

Workaround 

None. 
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Java Web Start 

This section describes known problems related to Java Web Start deployment. 

QXCR1000305148: 
Starting SD 5 Client Deployment Using Java Web Start 
Problem 

If you deploy the Service Desk 5.0 Client from a UNIX-to-Windows system using Java Web Start, the name 
resolution must be consistent.  

Workaround 

Make sure that you do not have any inconsistency between the full Internet name and the alias name. For 
example, if you use http://myhostname.mydomain.org/ovconsole (full Internet name) as a command for 
downloading the Service Desk 5.0 Client on Windows, the deployment fails if the result of “hostname” is 
myhostname (alias name) on UNIX. 

QXCR1000289979:  
No Data is Presented on a Java Web Start Client After an Object Server Failover 
Problem 

No data is presented on a Java Web Start client after an Object Server failover. 

Prerequisites: 

Two installed management servers refer to one database. 

To reproduce the problem, follow these steps: 

1 Start two Java Web Start clients on two different machines, referring to different management servers. 

2 Stop one of the management servers. 

Expected results: 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. All data is still accessible.  

Actual results: 

After the failover, the Java Web Start client that referred to the stopped management server is connected 
automatically to the running management server. Data is not accessible anymore. Data creation is no longer 
possible. 

Workaround 

Download the Java Web Start client again by using the URL connecting the second application server. 
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QXCR1000294601:  
Service Level Created from Java Web Start is Not Visible on OvConsole 
Problem 

The service levels created on the Java Web Start console are not visible from OvConsole. 

To reproduce the problem, follow these steps: 

1 Start Java Web Start. 

2 Create one service level. 

3 Start the HP OpenView console. 

4 Open the list of service levels. 

You cannot see the service level created with the Java Web Start console.  

Workaround 

It is recommended that you reconnect to see other entities. The problem may be fixed after service levels are 
no longer cached. If a client updates a cached entity, other connected clients do not update their cache 
automatically. This design decision was made for performance reasons. Cached entities should be fairly 
static. At the time, the functional impact was considered to be low. 

QXCR1000244548:  
Traces Using Java Web Start 
Problem 

When a client is deployed using Java Web Start, some logs are not recorded. 

Some of the graphical user interface log messages are logged in the Object Server log file. 

Workaround 

None. 

QXCR1000324111: 
Java Web Console: Service Call SLA and Location Information are Not Retrieved from the 
Adding Caller 
Problem 

In the Java Web Console, in some cases a service and an SLA are not retrieved. 

To reproduce the problem, follow these steps: 

1 In the OV Configuration workspace, click System Settings. 

2 Double-click Service and SLA Retrieval Settings for Service Call.  

The Service and SLA Retrieval Settings for Service Call dialog box appears. 

3 In Automatic Service and SLA Retrieval in Service Call, select from the following fields: 

  Caller 

  Caller Organization 

  Service 
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4 Add the following search criteria in order:  

  Caller Organization Hierarchy 

  Locations of Organization Hierarchy 

  Caller 

  Caller’s Location 

5 Select Stop the Search if Services and SLAs are Found for a Particular Criterion. 

6 Select Enable Search and SLA Retrieval from Caller Location Field. 

7 Find the service level impact-priority mappings. 

Click Data→Codes→Service Level→Impact Priority Configuration. 

8 Create a new default impact-priority mapping named DIPM (for example, so a low impact maps to a low 
priority).  

All impacts must be mapped to priorities. 

9 Click Data→Codes→Service Call→Service Call Priority Duration Setting. 

10 Set the priority-duration settings from Top to Low priority: 1 hour, 2 hours, 4 hours, 6 hours, 8 hours, 
and so on.  

11 Click System Settings→General Settings, and select the Application tab. 

12 Deselect the Search Caller Person in Organization tree. 

13 In the Default Support Hours field, do the following: 

  Create and relate a support hours schedule named SHDefault, with Sunday 00:00 to 08:00 as the 
support hours. 

  Create a support hours schedule named SHA, with Sunday 12:00 to 00:00 as the support hours. 

  Create a support hours schedule named SHB, with Saturday 12:00 to 00:00 as the support hours. 

14 Add a Service Level workspace to a workspace group. 

15 Create a new service level named SLDefault, in which you relate the DIPM impact-priority mapping, 
and select Default. 

16 Create a service level named SL1 related to DIPM. 

17 Create a service level named SLB related to DIPM. 

18 Create two persons, and name them Caller1 and Caller2.  

19 Create an organization named Org. 

20 Make Caller1 and Caller2 members of Org. 

21 Create an organization named POrg, and set the child organization to Org. 

22 Create a business location named LoCaller, and relate persons Caller1 and Caller2 to this location 
(using the Works At field). 

23 Create a business location named LocPOrg, and relate it to POrg (using the Hosted At field). 

24 Create a service named SLocCaller, with the receiver LocCaller. 

25 Create an SLA named SLALocCaller, relate it to SLocCaller, with the receiver LocCaller, and 
relate service level SLB and support hours SHB (using the Schedules field). 

26 Log on to the Java Web Console using the system account. 
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27 Create a service call, setting Caller to Caller1. 

Expected results: 

•  Service is set to SLocCaller. 

•  SLA set to SLALocCaller. 

•  Caller location is set to LocCaller. 

Actual results: 

•  Service is not set. 

•  SLA is not set. 

•  Caller location is not set. 

•  In the HP OpenView Console, everything works as expected. 

Workaround 

If the caller location is entered in a service call, the service and SLA values are retrieved immediately. 

This error occurs only when the service receiver is a location. If the service receiver is an organization, the 
function works as expected. 

Smart Actions 

This section describes known problems related to Smart Actions. 

QXCR1000309377: 
Smart Action “Create Work Order” in a Service Call Generates an Error Message 
Problem 

When you open a Service Call form and start the action Create Work Order, you get the following error 
message: 

Windows cannot find 'Files/HP'. Make sure you typed the name correctly, and then try 
again. To search for a file, click the Start button, and then click Search. 

Every time the UI rule condition is met, an error occurs. 

Workaround 

1 In the OV Configuration workspace group, click Actions and Rules→Applications. 

2 Select Service Desk Form and change the command line.  

The Command Line field contains the following default value: 

call "$PRODUCTFOLDER$\bin\ovconsolecmd.bat"  

3 Remove the call command from the command line. 
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Usability 

This section describes known usability problems, limitations, and workarounds in Service Desk. 

QXCR1000303777:  
Service Today 
Problem 

Automatic refresh does not work in the Service Today view. In the default filter pattern, a newly created 
Service Today view does not show any items.  

Workaround 

In the View menu, click the Refresh button to see the latest calls. 

QXCR1000290261: 
SQL Server-Specific Errors: Cannot Create a Row of Size 14072 
Problem 

After you fill in all of the fields in a form completely using SQL Server, and then try to save the form, you 
may get an error message.  

Workaround 

Remove some information from the form. 

Known Limitations 

This section describes the known limitations of this Service Desk release. 

Schedule Elements in Schedule Elements 
You cannot include a schedule element in a schedule element. If you want to include a schedule element B in 
a schedule element A, you must include (or exclude) the schedule elements in schedule element B. 

QXCR1000306550: 
Actual Start Field 
To prevent reporting problems, you must set the Actual Start field to 00:00:00 when you create or update an 
SLA. If you do not do so, either the first day does not display, or incorrect values (from the previous 
evaluation period) display. 

SD-SLM Installer on HP-UX 
The installer on HP-UX does not use the argument -x mount_all_filesystems=false to install the SD-
SLM packages.  

If there are file systems declared in /etc/fstab, the installation fails with the following error message:  

One or more filesystems that appear in the filesystem table are not mounted and 
cannot be mounted.  

To install SLM (remove one or more file systems), you must modify the file /etc/fstab.  

By design, the Software Distributor uses mount_all_filesystems=true as a default value. One reason 
for this is that filesystems may be mounted in the /opt/OV or /var/opt/OV rooted directory structure. 
In addition, the /opt/OV or /var/opt/OV directory structure may contain symbolic links that reference 
other mounted file systems. 
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QXCR1000241122:  
LoadObject 
The LoadObject functionality in Service Desk 5.0 currently uses Perl version 5.6. Unfortunately, Perl 5.6 
does not support Unicode. As a result, all Service Desk functionality that uses LoadObject cannot handle 
Unicode dataflow properly. This issue impacts all integrations that use LoadObject (for example, OVO for 
Windows and OVO for UNIX). 

Product Co-existence 

This section describes known product co-existence problems, limitations, and workarounds. 

HP OpenView products may share the same component on specific systems. When you install an  
HP OpenView product on a system where another HP OpenView product is already installed, the installer 
first verifies that the latest version of the shared component is installed. An older version of a component is 
replaced by the latest version during the install process. In some cases, the component process scheduled for 
replacement, and other dependent components, are stopped before installation. As a result, you may need to 
restart these stopped component processes after installation. For more information on restarting these 
component processes, refer to the relevant product documentation. 

OVO/W 7.21 and 7.5 
Problem 

When you install the Service Desk 5.0 client on a system where HP OpenView Operations for Windows 
(OVO/W) 7.21 or 7.5 Client is already installed, the OVO/W HP ITO Agent Windows Service stops. 

Workaround 

Restart the HP ITO Agent manually. 

OVO/U 7.1 
Problem 

When you install the Service Desk 5.0 client on a system where HP OpenView Operations for UNIX 
(OVO/U) 7.1 HP-UX Client is already installed, the OVO/U llbserver process stops. 

Workaround 

Restart the llbserver process manually. 
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OVO/U 8.1 
Problem A 

When you install or uninstall the Service Desk 5.0 client, agent, or OVO/U integration on a system where 
HP OpenView Operations for UNIX (OVO/U) 8.1 is already installed, the OVO/U ovcd process and the 
OVO/U agent stop.  

Workaround A 

Restart the ovcd process and the OVO/U agent manually. 

The order in which you start the SD agent and the OVO/U agent is important. Start the SD agent first, and 
then start the OVO agent.  

If you try to start the SD agent when the OVO agent is already running, the SD agent may fail to start.  

In the log files, you will then see the following error messages repeatedly:  

com.hp.ov.obs;WARNING;Unexpected null requester received  

INFO;Obs Agent stopped. INFO;Stopped: Object Server Agent. 

Problem B 

When you install or uninstall the OVO/U agent on a system where the Service Desk 5.0 Management Server 
is installed, the Service Desk processes stop. 

Workaround B 

Restart the Service Desk processes manually with the command ovc –start. 

QXCR1000323328: OVO/W-SD and OVO/U-SD Integrations: 
BBC Service Missing from opcagt After Installing SD 5.0 Client 
Problem 

When the Service Desk 5.0 stand-alone client is installed on a machine where the OVO Agent is installed, 
running the opcagt -status command no longer displays the BBC Local Location Broker service. Do not 
be alarmed. The omission of this service from the list does not impact the behavior of the OVO Agent. 

Workaround 

None. 
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Accessibility Support 
HP is working to ensure that new HP OpenView management software releases comply with the latest 
international accessibility standards.  HP OpenView Service Desk 5.0 accessibility includes an improved 
user interface interaction model that allows screen readers to support users with visual impairments, and 
enhanced keyboard navigation as an alternative to mouse control.   

Product characteristics based on accessibility standards include:  

•  No animations in the user interface 

•  No requirement for user speech 

•  Operability within a limited reach and strength 

•  No requirements for simultaneous actions except as provided by the operating system 

•  Consistent meanings of images  

•  No flashing at a frequency where photosensitive epilepsy is a risk 

•  Redundant coding of all audio signals as provided by the operating system 

•  No requirements for timed responses 

•  Consistent and well-defined focus and selection indicators 

•  Alternative text for images 

•  Redundant coding for use of color 

•  Online help optimized for screen readers 

HP OpenView Service Desk 5.0 supports accessibility on Microsoft Windows operating systems using JAWS 
for Windows 4.5.  For a more detailed report of product compliance with Section 508 of the American 
Rehabilitation Act, go to the Check Product Accessibility web page at http://vgwh3pro.cce.hp.com/508/.  
From the Select Product Category drop-down menu, select Software and Operating Systems, then click 
Go. On the next screen, select the product family HP OpenView Service Desk, then click Go. 

Accessible electronic manuals for this product can be requested from the HP OpenView Product Manuals 
web site at http://ovweb.external.hp.com/lpe/doc_serv/ by clicking the Send Feedback link near the 
bottom of the page, and specifying the product name, product version, operating system, and document 
names that you would like to obtain in fully accessible form.   
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To activate accessibility support for Service Desk: 

1 After product installation, look in the following directory  

%INSTALLDIR%\nonOV\jre\1.4\lib\ext  

On Windows, the INSTALLDIR is the following: 

C:\Program Files\HP OpenView 

Make sure the Sun Java 2 platform edition 1.4.x files are located in the following directory: 

  jaccess-1_4.jar 

  access-bridge.jar 

If the files are not in the correct directory, copy them from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles 

2 Add the AccessBridge directory to your path: 

PATH=%INSTALLDIR%\nonOV\jre\1.4\AccessBridge;%PATH%  

This step ensures that the DLLs are part of the Java Access Bridge, and can be found and instantiated. 

3 Make sure the accessibility.properties file is located in the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\lib   

If needed, you can copy the file from the following directory: 

%INSTALLDIR%\nonOV\jre\1.4\AccessBridge\installer\installerFiles 

The Java Virtual Machine (JVM) reads a number of property files as it starts up.   

4 Use each line in the accessibility properties file to enable different accessibility features.   

For example, to enable assistive technologies to use the Java Access Bridge, use a text editor to include 
the following line in the file: 

assistive_technologies=com.sun.java.accessibility.AccessBridge  

For additional properties examples and explanations (for example, how to set up screen magnifiers), 
refer to the Java Accessibility Utilities documentation: 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html 

For more about configuring accessibility with Sun Java applications, refer to the following web site: 

http://java.sun.com/products/accessbridge/docs/setup.html. 

Integration with Other HP OpenView Solutions 

For information about the integrations in Service Pack 1, refer to the HP OpenView Service Desk Data 
Exchange Administrator’s Guide. 
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Troubleshooting 

This section describes how to troubleshoot some problems in Service Desk. 

Installation Fails 

Problem 

The installation fails. 

Workaround 

If you installed the management server, examine the server_HPOvInstaller.txt log file. 

The component log files are located in %OVDATADIR%, in the HPOvInstaller directory.  

The paths and file names are as follows:  

•  Windows 

%TEMP%\HPOvInstaller\server_<build number>, where <build number> is the version and build 
number (for example, 5.00.742) 

package_msi_<component>_install.log, where <component> is the name of the component 

•  UNIX 

/var/tmp/HPOvInstaller/server_<build number>, where <build number> is the version and 
build number (for example, 5.00.742) 

package_depot_<component>_install.log, where <component> is the name of the component 

These log files hold information about the native installation of the component: 

•  Windows 

Search in the log file for Return Value 3, which usually indicates there was an error. 

•  HP-UX 

Examine the swagent.log file located in /var/adm/sw/swagent.log.  

Examine the Object Server log file for information about why the installation failed. 

The Object Server log file is located in the following directory: 

%OVDATADIR%/log/system0.0_enUS 

This file contains the information from the Object Server and its tools. Look at the bottom of the file for any 
exception or other error message that might explain the failure. 
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XPL Logging 

Problem 

You would like to change the way information is logged. 

Solution 

XPL logging uses the default Java logging.properties file. 

By default, this file is located in the following directory: 

C:\Program Files\HP OpenView\nonOV\jre\1.4\lib\logging.properties 

For this file to work, you must execute the following once:  

ovconfchg -ns xpl.log -set logparent true 

For example, if you want all the logs to be written to the console, add the following lines to 
logging.properties:  

handlers=java.util.logging.ConsoleHandler 

java.util.logging.ConsoleHandler.level=INFO 

java.util.logging.ConsoleHandler.formatter=java.util.logging.SimpleFormatter 

In the logging.properties file, you can specify the logging level: 

•  SEVERE 

•  WARNING 

•  INFO 

•  CONFIG 

•  FINE 

•  FINER 

•  FINEST 

For example, to specify finer logging for the Object Server, add the following to logging.properties: 

java.util.logging.ConsoleHandler.level=FINER 

com.hp.ov.obs.level=FINER 

Object Server Cache 

Problem 

The Object Server cache can cause problems.  

Solution 

If you encounter a problem when you start the Object Server using ovc –start, try to delete the Object 
Server cache files by deleting all of the files in the following folder:  

C:\Program Files\HP OpenView\data\datafiles\obs 
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Control Service Pid Files 

Problem 

You are unable to start the control service. 

Solution 

Execute the following command: 

del C:\Program Files\HP OpenView\data\tmp\*.* 

Console Does Not Show Any Workspaces 

Problem 

Your console screen does not display any workspaces. 

Solution 

Clear your user settings by executing the following command: 

del C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView\*.* /s /q 
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Support 
Please visit the HP OpenView support web site at:  

http://www.hp.com/managementsoftware/support   

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by being able to: 

•  Search for knowledge documents of interest  

•  Submit and track progress on support cases  

•  Submit enhancement requests online 

•  Download software patches 

•  Manage a support contract  

•  Look up HP support contacts  

•  Review information about available services  

•  Enter discussions with other software customers  

•  Research and register for software training  

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract.  

To find more information about support access levels, go to the following URL:  

http://www.hp.com/managementsoftware/access_level  

To register for an HP Passport ID, go to the following URL:  

http://www.managementsoftware.hp.com/passport-registration.html 
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Legal Notices 

© Copyright 2005-2006 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.  

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on 
all HP 9000 computers are Open Group UNIX 95 branded products. 

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries. 

Microsoft® is a U.S. registered trademark of Microsoft Corporation. 

OpenView® is a registered U.S. trademark of Hewlett-Packard Company. 

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.  

Windows® is a U.S. registered trademark of Microsoft Corporation. 

 


	HP OpenView Service Desk 5.0.2 Release Notes
	In this Version
	Documentation Updates
	Documentation Errata
	HP OpenView Performance Insight

	Installation Notes
	Software and Hardware Requirements
	Installation Problems
	Installation Problems on Solaris 9 and 10
	QXCR1000315787: Apache Startup
	Installation Freezes
	Error Messages in the Log Files
	QXCR1000312290: Unable to Depersist an Object

	Uninstall Steps (Windows Only)
	Uninstall Service Desk
	Remove Service Desk Files
	Remove the Self-Healing Services Registry Key


	Fixes
	Fixes in Patch 2
	Fixes in Service Pack 1

	Known Problems, Limitations, and Workarounds
	General Problems
	Upgrade on Clients Overwrites ovconsole.bat
	Restart of HP OpenView Ctrl Service Produces Error 193
	Incorrect Messages in the Log Files During Installation
	Log-on Exceptions
	QXCR1000349082: Content of the Latest Software Version Dialog in General Settings Has Disappeared
	QXCR1000327004: Installing Secondary Server Displays Install Database Content Warning
	QXCR1000329577: Self-Healing Registry Key Remains After Patch is Uninstalled
	QXCR1000244984: Incidents Generated by the Alarm Engine are Not Filled Correctly
	QXCR1000283641: Searching for Text from “Localized Text” Does Not Work
	QXCR1000242246: {I18N} Apache Service is Not Registered in the OS When Installed in a Non-ASCII Path

	Service Level Management
	Metric Adapters: Tuning the Query Limitations
	QXCR1000244984: Incidents Generated by the Alarm Engine are Not Filled Correctly
	QXCR1000329267: Evaluation Period Has Only 29 Days When Changing from February to March
	QXCR1000316864: Severe Errors in Join Tables Operation
	QXCR1000299666: SLM Licensing: No Messages Sent to the Client Console

	Java Web Start
	QXCR1000305148: Starting SD 5 Client Deployment Using Java Web Start
	QXCR1000289979: No Data is Presented on a Java Web Start Client After an Object Server Failover
	QXCR1000294601: Service Level Created from Java Web Start is Not Visible on OvConsole
	QXCR1000244548: Traces Using Java Web Start
	QXCR1000324111: Java Web Console: Service Call SLA and Location Information are Not Retrieved from the Adding Caller

	Smart Actions
	QXCR1000309377: Smart Action “Create Work Order” in a Service Call Generates an Error Message

	Usability
	QXCR1000303777: Service Today
	QXCR1000290261: SQL Server-Specific Errors: Cannot Create a Row of Size 14072

	Known Limitations
	Schedule Elements in Schedule Elements
	QXCR1000306550: Actual Start Field
	SD-SLM Installer on HP-UX
	QXCR1000241122: LoadObject

	Product Co-existence
	OVO/W 7.21 and 7.5
	OVO/U 7.1
	OVO/U 8.1
	QXCR1000323328: OVO/W-SD and OVO/U-SD Integrations: BBC Service Missing from opcagt After Installing SD 5.0 Client


	Accessibility Support
	Integration with Other HP OpenView Solutions
	Troubleshooting
	Installation Fails
	XPL Logging
	Object Server Cache
	Control Service Pid Files
	Console Does Not Show Any Workspaces

	Support
	Legal Notices

